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Safety Precautions

This chapter explains the safety precautions that need to be followed when using this product. Before using the

product, please read the product manual and any associated manuals referenced in it to correctly understand the

relevant safety information.

Failure to comply with the provisions of the safety precautions may result in death, serious injury, or equipment

damage.

The "Danger," "Warning," and "Caution" items in the manual do not represent all safety precautions to be

followed but serve as supplements to all safety precautions.

This product should be used in environments that meet the design specifications; otherwise, malfunctions may

occur, and any abnormalities in function or component damage due to non-compliance with relevant regulations are

not covered by the product quality guarantee.

Kinco will not be liable for any legal responsibility arising from personal safety accidents or property losses

caused by non-compliance with the content of this manual

To ensure the safe use of the product, this manual uses the following symbols and graphics to indicate

precautions and highlights safety-related important content. Please be sure to comply

Danger
Indicates dangerous behavior.
Failure to take appropriate precautions may result in serious personal injury or death.

Warning
Indicates warning behavior.
Failure to take appropriate precautions may result in serious personal injury or death.

Caution
Indicates general information or instructional behavior.
Failure to heed the corresponding prompts may lead to unforeseen consequences.
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When Power is Supplied
During power supply, do not touch any terminals or terminal blocks, and do not attempt to

disassemble any units. Especially during power supply or just after power is turned off,
capacitors need time to discharge, which may cause electric shock or other personal or
equipment hazards.

During Assembly
Assembly, wiring, maintenance, and inspection of this product should all be conducted by

professional personnel who have received relevant training in electrical equipment.
Do not use PLC in the following places: environments with dust, oil fumes, conductive dust,

corrosive gases, or flammable gases; exposure to high temperatures, condensation, wind, or rain;
environments with vibration or impact. Electric shock, fire, or misuse may also result in product
damage.

During screw assembly or wiring, be careful not to allow metal shavings, dust, or wire ends to fall
into the ventilation holes of the PLC. Otherwise, it may cause fire, malfunction, or unintended
actions of the PLC.

Wiring
During power supply, do not touch any terminals or terminal blocks, and do not attempt to

disassemble any units. Especially during power supply or just after power is turned off,
capacitors need time to discharge, which may cause electric shock or other personal or
equipment hazards.

Before wiring operations, please ensure that all external power supplies to the system are
completely disconnected. Otherwise, there is a risk of electric shock to personnel and equipment
malfunction.

After completing the installation and wiring operations, before energizing and operating the
product, ensure that it is fully assembled (including end caps, plate covers, etc.), otherwise there
may be a risk of electric shock.

Cable terminals should be properly insulated to ensure that the insulation distance between cables
does not decrease after the cables are installed on the terminal block. Otherwise, there is a risk of
electric shock, short circuit, or equipment damage.

During screw assembly or wiring, be careful not to allow metal shavings, dust, or wire ends to fall
into the ventilation holes of the PLC. Otherwise, it may cause fire, malfunction, or unintended
actions of the PLC.

Before connecting relevant cable connections, confirm the type of interface to be connected.
Incorrect wiring may lead to controller or external equipment malfunctions or damage.

Tighten the bolts on the terminal block within the specified torque range. Loose terminal bolts may
result in circuit shorts, disconnections, fires, and other hazards. Over-tightening the bolts may
damage the bolts and the controller, leading to component detachment, circuit shorts, fires, and
other hazards.

When using connectors and connecting external devices, use the tools specified by the
manufacturer for pressing, crimping, or correct soldering. Poor connections may lead to shorts,
fires, and other hazards.

Do not bundle control lines and communication cables with main circuit or power supply lines, or
place them too close to each other. Control lines and communication cables should be arranged at
least 100mm away from main circuit power lines in cable ducts or spaces to avoid interference
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due to electromagnetic noise.

For applications with severe interference, use special shielded cables for high-frequency signal
input or output to improve the system's anti-interference capability.

During System Design

When applying, it is essential to design a safety circuit to ensure that the control system remains
safe even in the event of a power failure or controller malfunction.

If the output circuit experiences prolonged overcurrent due to exceeding the rated load current or
load short circuits, the controller may smoke or catch fire. Therefore, external safety devices
such as fuses or circuit breakers should be installed to interrupt power.

It is crucial to set up emergency braking circuits, protection circuits, interlocking circuits for
forward and reverse operations, and upper and lower limit interlock switches in the external
circuits of the controller to prevent machine damage.

To ensure safe equipment operation, design external protection circuits and safety mechanisms for
significant accident-related output signals.

When the controller's CPU detects abnormalities in its system, it may automatically shut off all
output signals. Additionally, partial circuit failures in the controller may result in uncontrolled
outputs.

To ensure equipment's normal operation, suitable external control circuits need to be designed.
Damage to the transistor output unit of the controller may render its output status uncontrollable.
Programmable controllers should be designed for use in indoor electrical environments with

overvoltage level II. The power supply system level should include lightning protection devices
to prevent lightning-induced overvoltage from affecting the programmable controller's power
input terminals, signal input terminals, control output terminals, and other ports, thus avoiding
equipment damage.

During Operation and Maintenance

Assembly, wiring, maintenance, and inspection of this product should all be conducted by
professional personnel who have received relevant training in electrical equipment.
Before cleaning or tightening the bolts on the terminal block or installing connector bolts, please

ensure that the system's power supply is completely disconnected.

Before making any online modifications to the program, forcing outputs, starting (RUN), or
stopping (STOP) operations during equipment debugging, it is essential to thoroughly read the
user manual. Only proceed with these operations after ensuring their safety.
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1 General description

1.1 Product introduction

Kinco MK series product combine the advantages of HMI+PLC+ iot technology.It is an economical integrated

product that supports the iot function.

MK series adopts high-performance CPU and applies the new DTools software technology platform while

retaining the high cost-effectiveness of the HP series all-in-one machine, which can support more rich picture

components and functions. In addition, combined with the kinco machine iot platform to provide remote download,

transparent PLC, VNC monitoring, device management and other remote operation and maintenance functions to

provide more value to the majority of users.

1.2 Product information

1.2.1 Naming rule

The naming rules for product models are as follows:
Module type + Number of channels + function identification , as shown in figure:

In the MK series, except the MK070E-32DX body has no analog，other models body have analog input

/ output. In addition, the MK043E-27DT body has a 4-channel DIO, which can be used as a drain type DI input or

source type DO output according to the connection method.
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According to the above principles, MK070E - 33DT stands for the DC 24 V power supply, the total input/output

channels is 33 (16*DI , 14*DO , 2*AI , 1*AO) of 7 inch integrated machine; MK043E-20DT stands for the DC 24 V

power supply, the total input/output channels is20 (9*DI , 9*DO , 2*AI) of 4.3 inch integrated machine.

1.2.2 Nameplate information

NO. Deacription

① EAC certification

② Model

③

The 1st~6th codes indicate product code, which ensures uniqueness for different
models.
The 7th~8th codes indicate the production year, indicating the year of production
(e.g., "17" for 2017) .
The 9th~11th codes indicate the production day, indicating the day of production
within the year (e.g., "148" for the 148th day of the year).
The 12th~16th codes indicate the production sequence of the product on that
particular day, indicating the sequential order of production for products of the same
model on that day (e.g., "001" for the first product).

④ Product serial number barcode

⑤ CE certification

⑥ RoHS certification
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1.3 Operating and Storage Conditions

The MK series products complies with the GB/T 15969.3-2007 (equivalent to IEC61131-2:2007) standard and

testing specifications.

Transportation and Storage

Environmental
conditions

Temperature -40℃～+70℃

Relative humidity 10%～95%，non-condensing

Atmospheric pressure Altitude of 0～3000 meters above sea level

Mechanical
conditions Free fall With transportation packaging, allowed to fall 5 times from a height

of 1 meter onto a cement surface.

Operating conditions

Environmental
conditions

Temperature Naturally ventilated open device, -10～55℃

Relative humidity 10%～95%，non-condensing

Atmospheric pressure Altitude not exceeding 2000 meters

Pollution Level Level 2

Mechanical
conditions

Sinusoidal vibration

5<f<8.4Hz:
Random vibration displacement: 3.5mm
Continuous vibration displcement: 1.75mm
8.4<f<150Hz:
Random vibration acceleration: 1.0g
Continuous vibration acceleration: 0.5g

Shock Half-sine wave, 15g, 11ms, six times per axis

Electromagnetic
Compatibility

(EMC)

Electrostatic discharge
Air discharge: 8KVWithstands
Contact discharge: 4KVWithstands
Level B

Surge

AC power supply: 2KV CM, 1KV DM
DC power supply: 0.5KV CM, 0.5KV DM
IO and communication interface: 1KVCM
Level B

EFT
(Electrical Fast Transient)

Power supply coupling: 2KV, 5KHz
IO and communication coupling: 1KV, 5KHz
Level B

Voltage dip
AC system, at 50Hz, voltage drop to 0% for 1 cycle, 40% for 10
cycles, 75% for 20 cycles.
Level A

Ingress
protection

Waterproof
and dustproof IP20
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1.4 Product List

Standard product MK070E-33DT MK070E-32DX MK043E-20DT

Power supply DC24V（Range：DC 20.4V-DC 28.8V）

DI/DO

DI 16*DC24V(PNP/NPN) 16*DC24V（PNP/NPN） 9*DC24V(PNP/NPN)

DO 14*DC24V(PNP)
4*DC24V(PNP)

12*Relay
9*DC24V(PNP)

DIO / / /

AI/AO
AI 2*AI /

2*AI
Support 0-10V signal

AO 1*AO / /

Interface

Programmatic
interface

USB-Slave/RS485(Port1)

CAN 1*CAN,support CAN free communication

Serial
communication

2*RS485

Expansion module Supports 8 KS series extensions

Screen size 7"TFT 4.3"TFT

Screen
quality

Resolution ratio 800*480 pixel resolution 480*272 pixel resolution

Colour 256K color

Brightness 250cd/m^2

HMI type 4-wire precision resistance network touch screen

Interface

Ethernet 10M/100M adaptive Ethernet interface, can download HMI configuration program

USB-Host Supports extended memory and external device

USB-Slave PLC, HMI program download interface

Note:

DC24V of DI and DO in the table indicates the transistor type, and Relay indicates the relay type.

The AI/AO rows in the table supports 4-20mA/1-5V/0-20mA/0-10V signals.
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Standard product MK070E-27DRT MK043E-20DTC MK043E-27DT

Power supply DC24V（Range：DC 20.4V-DC 28.8V）

DI/DO

DI 12*DC24V(PNP/NPN) 9*DC24V(PNP/NPN) 10*DC24V(PNP/NPN)

DO 12*Relay 9*DC24V(PNP) 10*DC24V(PNP)

DIO /
/

4*DC24V
Change the input/output function
of each channel according to the

wiring, can be mixed

AI/AO
AI

3*RD
Support Pt100 thermal
resistance, temperature

measuring range
-40℃-240℃

2*TC
Support J/K/E/T
thermocouples

2*AI

AO / / 1*AO

Interface

Programmatic
interface

USB-Slave/RS485(Port1)

CAN 1*CAN,support CAN free communication

Serial
communication

2*RS485

Expansion module Supports 8 KS series extensions

Screen size 7"TFT 4.3"TFT

Screen
quality

Resolution ratio 800*480 pixel resolution 480*272 pixel resolution

Colour 256K color

Brightness 250cd/m^2

HMI type 4-wire precision resistance network touch screen

Interface

Ethernet 10M/100M adaptive Ethernet interface, can download HMI configuration program

USB-Host Supports extended memory and external device

USB-Slave PLC, HMI program download interface

Note:

DC24V of DI and DO in the table indicates the transistor type, and Relay indicates the relay type.

The AI/AO rows in the table supports 4-20mA/1-5V/0-20mA/0-10V signals.
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Economy product MK070C-33DT MK043C-20DT

Power supply DC24V（Range：DC 20.4V-DC 28.8V）

DI/DO

DI 16*DC24V(PNP/NPN) 9*DC24V(PNP/NPN)

DO 14*DC24V(PNP) 9*DC24V(PNP)

AI/AO

AI 2*AI
2*AI

Support 0-10V signal

AO 1*AO /

Interface

Programmatic
interface

USB-Slave/RS485(Port1)

CAN Not supported

Serial
communication

1*RS485(Port1)

Expansion module Not supported

Screen size 7"TFT 4.3"TFT

Screen quality

Resolution ratio 800*480 pixel resolution 480*272 pixel resolution

Colour 256K color

Brightness 250cd/m^2 400cd/m^2

HMI type 4-wire precision resistance network touch screen

Interface

Ethernet -

USB-Host Supports extended memory and external device

USB-Slave PLC, HMI program download interface

Note:

DC24V of DI and DO in the table indicates the transistor type.

The AI/AO rows in the table supports 4-20mA/1-5V/0-20mA/0-10V signals.

2 Product overview and hardware description

2.1 Features introduction
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Built-in iot function, support program upload/download, transparent PLC, VNC monitoring, equipment
management and other rich remote operation and maintenance functions, easy to use and powerful in
functionality, taking into account the application needs of customers in various occasions.

The HMI part adopts industrial CPU, 700MHz main frequency, 128MB Flash+64MB DDR2 large-capacity
storage, and supports Kinco new generation of HMI DTools programming software to further improve product
performance.

The standard body are equipped with 10/100M adaptive Ethernet port, which can access Ethernet devices and
support USB extended storage, the MK043E-27DT adopts Type-C interface as the programming port and is
compatible with common Type-C mobile phone data cable, which provides convenience for users to program
and debug the device.

Four DIO have been added to the PLC section of MK043E-27DT, which can be used as both DI and DO, simply
follow the corresponding wiring method and no other configuration is required. An RS232 serial port has been
added to the display section for direct data exchange with external devices

MK series support a variety of expansion modules, standard product can expand 8 KS expansion modules,
meeting users' various application needs and offering higher cost-effectiveness.

Provide 4 high-speed pulse outputs, all supporting PTO (pulse train) and PWM (pulse width modulation) output
modes. KincoBuilder software provides PLS (PWM or PTO), positioning control command group, PFLO_F
(follow command), etc., making it convenient for users to implement simple motion control applications.

In addition to the economy model, the other models include two RS485 interfaces (Port1 and Port2), with a
maximum communication rate of 115.2kbps, of which Port1 supports programming protocols, Modbus RTU
master station, slave station and free communication functions. Port2 supports Modbus RTU master station,
slave station, and free communication.

KincoBuilder software provides easy to use motion control commands, the software is equipped with motion
control wizard function to help users get started with zero threshold, fast configuration, efficient
programming.
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2.2 Component and interface description

2.2.1 MK070E component description

Note:

MK070E-33DT/MK070E-32DX/MK070E-27DRT components are the same, only the total number of input and

output points are different

No. Name Function
① Display and touch LCD screen Display and touch area
② Status indicator light Indicate current status of the MK

③ Digital output channel terminal Used for connecting digital output signal, the wiring is fastened
with screws, and the terminals are detachable

④ Digital input channel terminal Used for connecting digital input signal, the wiring is fastened
with screws, and the terminals are detachable

⑤ Analog output channel terminal Used for connecting analog output signal, the wiring is fastened
with screws, and the terminals are detachable

⑥ Analog input channel terminal Used for connecting analog input signal, the wiring is fastened
with screws, and the terminals are detachable

⑦ Power terminal Access DC24V power supply

⑧ DB9 interface Supports 2*RS485 (Port1, Port2) and KS extension
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⑨ USB Host interface
HMI expansion interface for peripheral devices such as storage
devices, keyboards, or mouse

⑩ CLR button PLC program clears physical key

⑪ Ethernet interface
For Ethernet communication connection, can connect to PC to
view HMI information and download configuration program

⑫ USB Slave interface
Connect to PC to view MK information, download PLC
program and HMI configuration program

⑬ Sealing ring
To prevent dust or fine particles from entering the installation
gap, the sealing ring can be removed

2.2.2 MK043E-20DT component description

No. Name Function
① Display and touch LCD screen Display and touch area

② Digital output channel terminal Used for connecting digital output signal, the wiring is fastened
with screws, and the terminals are detachable

③ Digital input channel terminal Used for connecting digital input signal, the wiring is fastened
with screws, and the terminals are detachable

④ Power terminal Access DC24V power supply

⑤ Analog input channel terminal Used for connecting analog input signal, the wiring is fastened
with screws, and the terminals are detachable

⑥ DB9 interface Supports 2*RS485 (Port1, Port2) and KS extension
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⑦ USB Host interface HMI expansion interface for peripheral devices such as storage
devices, keyboards, or mouse

⑧ CLR button PLC program clears physical key

⑨ Ethernet interface For Ethernet communication connection, can connect to PC to
view HMI information and download configuration program

⑩ USB Slave interface
Connect to PC to view MK information, download PLC
program and HMI configuration program

⑪ Sealing ring
To prevent dust or fine particles from entering the installation
gap, the sealing ring can be removed

2.2.3 MK043E-27DT component description

No. Name Function
① Display and touch LCD screen Display and touch area

② Digital output channel terminal Used for connecting digital output signal, the wiring is fastened
with screws, and the terminals are detachable

③ Digital input channel terminal Used for connecting digital input signal, the wiring is fastened
with screws, and the terminals are detachable

④ Power terminal Access DC24V power supply

⑤ Analog output channel terminal Used for connecting analog output signal, the wiring is fastened
with screws, and the terminals are detachable

⑥ DIO channel terminal
According to the corresponding connection mode, as DI, DO
single or mixed use, the wiring is fastened with screws, and the
terminals are detachable
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⑦ Analog input channel terminal Used for connecting analog input signal, the wiring is fastened
with screws, and the terminals are detachable

⑧ DB9 interface Supports 2*RS485 (Port1, Port2) and KS extension

⑨ USB Host interface
HMI expansion interface for peripheral devices such as storage
devices, keyboards, or mouse

⑩ CLR button PLC program clears physical key

⑪ Ethernet interface
For Ethernet communication connection, can connect to PC to
view HMI information and download configuration program

⑫ USB Slave interface
Connect to PC to view MK information, download PLC
program and HMI configuration program

⑬ Sealing ring
To prevent dust or fine particles from entering the installation
gap, the sealing ring can be removed

2.2.4 MK series product dimension

Model MK070E MK043E-20DT/MK043E-20DTC MK043E-27DT

Installation dimension

L*W (mm)
192*138 119*93 119*93

Boundary dimension

L*W*H (mm) 204*150*33.9 132*102*31.5 132*102*45.42

The L, W and H marked in the figure are the first letters of Length, Width and Height respectively. Installation

dimension refer to the dimension required for the MK to be installed on other components,as indicated by the red

box in the diagram. Boundary dimension refer to the dimension of the length, width and height of the outermost edge

of the MK.
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2.2.5 Component function description

2.2.5.1 Status indicator light

In the MK series, only the 7-inch integrated machine is equipped with a status indicator light on the panel.

According to the user's usage and feedback, the panel indicator light has been updated twice, and the differences

before and after the update will be explained below.

There are three types of indicator lights on the MK series panel: PWR, RUN, and STA, which are used to

indicate the current operation status of MK.

[PWR] : Power status indicator light. When the power supply is normal, the PWR

light turn on (green).

[RUN] : PLC operating status indicator light. It turn on (green) during normal

operation.

*[STA] : PLC error indicator light, the latest panel indicator light,When an error is

detected in the user program or CPU , the STA light will turn on (blue).

*[Err] : PLC error indicator light, the old panel indicator light,When an error is

detected in the user program or CPU , the Err light will turn on (red).

*[Com] : Communication status indicator light, initial panel indicator light,When

either communication port (Port1/Port2) is used for receiving or transmitting, the

COM light will blink (green).

 Indicator light status description
Indicator light Color Status Description

PWR Grey（off）/
Green (on）

Light keeping on Power supply normal

Off Power supply is abnormal or disconnected

Run Grey（off）/
Green (on）

Light keeping on PLC is in running status
Blink PLC is in firmware update mode
Off PLC not running

STA Grey（off）/
Blue (on）

Light keeping on User programor PLChas encountered an error
Off No error detected by PLC

Err.
[Old indicator light]

Grey（off）/
Red (on）

Light keeping on User program or PLC has encountered an error, user can
view the specific error through KincoBuilder

Off No error detected by PLC

COM
[Old indicator light]

Grey（off）/
Green (on）

Blink Any communication port is in the receiving or sending state

Off The current COM port is not working

The CPU categorizes errors into three levels: fatal error, critical error, and general error. When the CPU detects

an error,STA indicator light on and stores the specific error codes in order of occurrence. Users can view the specific

error information through the KincoBuilder programming software for analysis. For specific fault analysis, please

refer to section 4.7 Error Information and Handling
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Error type Run Err. Description

Fatal error
（Access security

subsystem）

OFF Blink

When a fatal error occurs, the PLC will immediately exit
the normal scanning state, and according to the value of
the special register SM2.0 to determine whether to directly
reset the PLC or enter the independent security subsystem
operation:
If the SM2.0 = 0, the PLC will enter the independent
security subsystem operation after a fatal error
If the SM2.0 = 1, the PLC will be reset and restarted
directly after a fatal error.
The default value of the special register SM2.0 after
power on is 0

*PLC in the security subsystem state will enter the state of
unable to communicate and use.
*When entering the security subsystem due to a user
program running error, the PLC can be restored to normal
operation status through the [Tools] → [Clear (for fatal
errors state)] in the menu bar or the CLR button.
*If the PLC enters the safety subsystem due to hardware
damage or firmware bug, it cannot be restored to normal
operation through clearing and CLR key

Critical error OFF Light keeping on
A critical error in the PLC will prevent the user program
from continuing to run correctly, but the result is
predictable.

General error Light keeping on Light keeping on
General error occurs when a PLC performs a certain
function, but other parts of the program can continue to
run with predictable results.

Figure 2.2.5-1 PLC information and errors
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The CPU has two main states:Run and Stop. In the running state, the CPU module executes the main scanning

task and various interrupt tasks in a normal cycle. In the stopped state, the CPU module only processes some

communication requests (including programming, debugging, and other commands from the KincoBuilder

software, as well as communication commands from the Modbus RTU slave station in response to the master station),

and immediately outputs all output points (DO, AO) to the "shutdown output" value defined in the [hardware

configuration] of the user project.

 Change CPU state method

In general, when the PLC is powered on and online normally, PLC default state is the startup state. Users can

change the CPU state through Ki ncoBuilder:

 Connect the CPU module to the PC, refer to KincoBuilder hardware configuration and connection and

program upload /download

 In KincoBuilder software menu bar execute [Debug] → [Start PLC] Or [Stop PLC] menu command

Figure 2.2.5-2 Switching PLC status
Note:

If the PLC detects a serious error during operation, it will immediately enter the stop state.

If the PLC fails to download the program midway, the PLC will maintain the software-controlled STOP state.

2.2.5.2 CLR program clear physical key

In order to avoid the PLC crash caused by program logic error, the CLR key is set behind the MK, which is

used to clear the user program inside the PLC and restore normal operation when a fatal error occurs during program

operation and enters the safety subsystem.The steps to clear the PLC user program using physical key are as follows:

1. After pressing the key, it will enter the pre-clear state after about 5s, at this time, the STA light turns on and

off with a cycle of 2s,if the user has been pressing the key, it will be maintained in this state;

2. Release the key (at least 2s) , and enter the state of waiting for user confirmation. At this time, the STA light

turns on and off with a cycle of 600ms. If the user releases the key for more than 60s,PLC will completely

exit the program clearing function and return to the state before pressing the key.

3. Press the button(at least 5s) for user confirmation, and the PLC begins to clear the internal user program.

When the PLC clears the internal user program, the STA light is keeping on , the PLC does not respond to any

other action, if the clearance is successful, the STA light is on and off twice for a cycle of 2s, if the clearance fails,

the STA light is on and off for 4 times for a cycle of 1s. After successfully clearing the user program, it is necessary

to power off and restart the PLC within 60s , otherwise it is necessary to perform the above clearing steps again.

Considering the factors of preventing mechanical shaking and user misoperation, the CLR key can be pressed

and released in each of the above steps, without affecting the function, and the user can operate with confidence.
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2.2.6 MK back interface and pin description

2.2.6.1 DB9 interface

The DB9 interface behind the MK provides 2*RS485 (Port1, Port2) communication, both support ModbusRTU

master/slave station, free communication function, of which Port1 can be connected to download programs. EX.

indicates an expansion port that supports a maximum of 8 KS expansion modules. DB9 interface of some MK

models support different communication protocols, and you need to correctly connect pins based on the wiring

diagram of the model.

The following figure shows the pin numbers of the DB9 interface. In addition, there are pin number marked

with silk screen printing on the DB9 female port (as shown in the figure), user can use light to view the

corresponding pin number.

Figure 2.2.6-1 DB9 interface Figure 2.2.6-2 DB9 interface silk screen printing

The following table shows the ports, pin numbers, and meanings used by each communication protocol in the

DB9 interface. It should be noted that COM2 is only supported in DB9 interfaces of the MK043E-27DT model.

The bus topology structure of RS485 is shown in the following figure. It is recommended that the customer

connect a 120Ω terminal resistor to the first and last ends of the bus when in use.

Figure 2.2.6-3 RS485 topology structure

Protocol interface Pin Signal Meaning
Port1

（RS485）
6 A RS485 signal，TXD+/A
1 B RS485 signal，TXD-/B

Port2
（RS485）

9 A RS485 signal，TXD/A
4 B RS485 signal，TXD/B

CAN 7 CAN_H CAN bus signal, high level
2 CAN_L CAN bus signal, low level

COM2
（OnlyMK043E-27DT）

3 RXD Rceive data
8 TXD Send data

GND 5 GND Ground
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2.2.6.2 USB-Host interface

The USB-Host interface enables the HMI to connect to external devices. Users can connect to external storage

devices, a mouse, or a keyboard, providing various information input methods. For details about how to set the

parameters on the DTools software, see 5.4.2 KincoDTools user manual.

Pin Signal Description

1 5V USB power supply

2 DATA- USB data signal negative

3 DATA+ USB data signal positive

4 GND Ground

2.2.6.3 EtherNet interface

The MK series CPU modul is equipped with a 10/100M Ethernet port (in accordance with the IEEE802.3

standard specification), in the form of RJ45. Users can access the external network or other Ethernet device, the

interface supports programming protocols, can download the HMI configuration program

Indicator light Color Status Description

Green light Gray green（off）
/Green（on）

Light keeping on 100M communication connection

Off 10M communication connection

Blink Data is being sent and received

Light keeping on No data is being sent or received

The default factory IP address of the MK CPU module is 192.168.0.252. User can use the ethernet interface to

communicate with HMI through KincoDTools. For the communication configuration, see 4.6.1 MK series PLC

communicate with PC via USB-Slave .

EtherNET interface communication cable using direct cable or cross cable . The Ethernet interface on the CPU

module provides the "auto negotiation" function. When a cable is inserted, it automatically negotiates with the

communicate device to determine the cable type to be used.

Pin Signal Description

1 TD+ Send+

2 TD- Send-

3 RD+ Receive+

4

5

6 RD- Receive-

7

8
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2.2.6.4 USB-Slave (USB-B&Type-C)

USB-Slave is the PLC, HMI general program download interface, in the MK series only MK043E-27DT

USB-Slave uses the Type-C interface, the use of mobile phone data cable can be connected to download programs,

other MK models use USB-B interface.

After the programming data cable is connected to the computer, the virtual serial port is created on the computer

for communication. Each version of Windows10 and Wi ndows11 comes with the USB driver of the KPLC part. The

user does not need to install the driver. The computer system before Win10 needs to install the driver before it can be

used.In general, when using the programming data cable to connect the device and the computer, the Windows

system will automatically detect the new hardware and prompt the installation of the driver. If there is no

corresponding prompt, the \ Drivers folder in the KincoBuilder installation directory contains driver programs that

support Windows XP, Windows 7, and Windows 8 systems. Users can choose the driver program according to their

own Windows version for installation.

The USB driver is also stored in \Drivers in the installation directory of KincoDTools. User need to manually

install the USB driver in the Hardware Update Wizard dialog box that is automatically displayed on the PC

operating system.

For communication configuration, see 4.6 Connection and program upload/download.

Figure 2.2.6-4 USB-B data cable

Figure 2.2.6-5 USB-B pin number

Pin Signal Description

1 5V USB power supply

2 DATA- USB data signal negative

3 DATA+ USB data signal positive

4 GND Ground
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2.2.6.5 Anti-demolition warranty label

There is an anti-demolition warranty label on the side of the MK series plc, which is the main basis for users

and maintenance personnel to confirm whether the product is dismantled. If the user destroys the anti-demolition

warranty label, it will be regarded as artificial damage, so it is not within the scope of warranty. The relevant

after-sales service terms can be logged in the official website of kinco and viewed in Services→ After-sales service

→ Terms and conditions

Figure 2.2.6-6 anti-demolition warranty label

2.2.7 PLC function support description

2.2.7.1 Data maintain and permanent storage

Data maintain refers to the ability to retain data stored in random-access memory(RAM) even after the CPU

loses power, preserving the data in the same state it was before the power loss, then available for the CPU to use

when it powers up again. The data retention function relies on a backup battery (CR2032) provided within the

CPU to maintain power and preserve the data stored in RAM memory after a power outage.Operating with intemal

RAM provides fast read/write speeds and unlimited memory lifespan.However, once the battery is depleted, all data

will be lost，so user needs to pay attention to the backup battery power situation. User can through the special

register SM 0.7 to monitor the battery voltage is normal (SM0.7= TRUE, low battery voltage; SM0.7= FALSE, the

battery voltage is normal). Under nomal temperature conditions data retention can last for a cumulative period of at

least 3 years.

User needs to use KincoBuilder software to select the data area type (such as V area, C area, start address,

length, etc.) to be maintained in the user project [PLC hardware configuration]. The maximum data retention for the

MK series V area is 1908 bytes (VB0~VB1907), and the maximum data retention for the C area is 64 bytes

(C0~C63). For details, see 2.2.8.8 Program storage and RTC.

撕毁保修无效
Warranty void if label broken
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Figure 2.2.7-1 Data maintain setting

Permanent storage refers to a designated area in the CPU's non-volatile memory (E2PROM) .The data stored

in this area will not be lost even when power is disconnected. However,the E2PROM has limitations in terms of

lifespan and write speed, so frequent or rapid writesshould be avoided.

The K series PLC provide a permanent data storage area within the V area. The data in this area will be

automatically written to the EEPROM, and you can directly utilize these areas during programming. For the MK

series PLC, it supported data backup areas are VB3648-VB3902 andVB3648-VB4905.

Figure 2.2.7-2 Permanent storage setting

Project Meaning

Compatible with K3（VB3648-VB3902）
This option indicates that VB3648-3092 will be activated as the data backup
area,and the data in this area will be automatically written into pemanent
storage(EEPROM).

Compatible with K5（VB3648-VB4095）
This option indicates that VB3648- 4905 will be activated as the data backup
area,and the data in this area will be automatically written into pemanent
storage(EEPROM).

Compatible with K6（VB15360-VB16383）
This option indicates that VB15360-16383 will be activated as the data
backup area,and the data in this area will be automatically written into
pemanent storage(EEPROM)

All of the above areas are used
This option indicates that VB3648- 4095 and VB15360-16383 wil be
activatedtogether as the data backup area, and the data in this area will be
automatically written into pemanent storage(EEPROM)

All of the above areas are Not used This option indicates that no permanent storage area will be configured.

Note:

The erase/write lifespan of the EEPROM is 1 million times(1 ,000,000). Therefore, data with high-frequency

changes should not be stored in the addresses of the permanent storage area.
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2.2.7.2 Real-time clock

The MK series PLC integrates a real-time clock (RTC), providing real-time time/calendardisplay. The format of

the real-time clock/calendar (year/month/day, hour/minute/second) is encoded in BCD format, automatically

adjusting for leap years. When the CPU is powered off, the real-time clock relies on backup battery power to

maintain operation. At room temperature, the typical lifespan of the battery is 5 years, with a cumulative retention

time of no less than 3 years in a power-off state.

When using the RTC for the first time, you needs to set the clock by executing the [PLC]-[Adjust CPU Clock... ]

menu command in KincoBuilder. After that, the READ_RTC, SET_RTC, RTC_W, and RTC_R instructions can be

used to implement related control functions.

Figure 2.2.7-3 Adjust CPU clock

The real-time clock (RTC) function of the HMI part adopts BIN encoding format to provide real-time time and

calendar display, and users can modify the time by entering the system Settings interface or special registers

(LW10000-LW10006). If you need to synchronize the HMI display time with the PC time, this topic describes a

simple time synchronization method. For more details, see 2.7 Clock Setting in the KincoDTools user Manual.

Time synchronization through KDManager

Open KDManager, click [System Operate] on the left, then click[Set] to enter the Communication set and click

[OK] after setting, finally click the [Synchronization system time].
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Figure 2.2.7-4 KDManager communication set

Figure 2.2.7-5 KDManager synchronizing system time
The preceding operation must be performed after the PC is successfully connected to the HMI.

Backup battery

The MK series CPU uses a specific specification lithium battery as the backup battery. When CPU is power off,

the backup battery is used to power the real-time clock to maintain its operation and also powers the RAM to retain

data.

When the battery level is low, there will be an alarm message in KincoBuilder under [PLC Information]-

[General Errors] prompting the user to replace the backup battery.

The backup battery can’t be rechargeable and it requires removing the cover for

replacement.After opening the cover, the battery as shown in the diagram on the right, you can

see and replace. The battery is a lithium battery(CR2032, 3V). You can order the battery

separately; for detailed ordering information, please contact the sales service center.

Battery replacement method

Remove the terminal of each channel, remove the hex socket head cap screw, and cut or tear off the warranty label

on the side,so you can remove the rear cover.

After opening the cover, you will see the RTC battery on the upper circuit board. To ensure the battery's stability, it

is typically fixed with electronic adhesive silicone gel after installation. At this point, you need to remove the

adhesive used for fixation.

Use a screwdriver or finger to pry the battery connector male and pull it out.

Install the new battery connector male on the female socket of the circuit board, tear off the sponge sticker on the

battery, and secure the battery in the proper position.

Finally, in order to stabilize the battery, please put silicone on the battery connector to fix it.
Note:
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Please follow local waste disposal and recycling regulations for proper disposal of the old lithium battery.

2.2.7.3 High speed counting function

The MK series CPU support 4 high-speed pulse counters.numbered HSC0 to HSC3, covering single-phase

/two-phase (UP/Down)/AB (1 multiple frequency and 4 multiple frequency) equal counting modes. The maximum

counting frequency of MK series CPU each model is as follows:
Single-phase AB single

HSC0 and HSC1 HSC2 and HSC3 HSC0 andHSC1 HSC2 andHSC3
50KHz 50KHz 50KHz 50KHz
50KHz 50KHz 50KHz 50KHz

Each channel operation mode and hardware allocation

HSC0

Model Description I0.1 I0.0 I0.5

0
Single-phase up/down counter with intemal
direction control
Direction control bit: SM37.3

Clock

3 Single-phase up/down counter with external
direction control Clock Direction

6 Dual-phase counter with up/down counting clock Clock（decrease） Clock
（increase）

9 AB phase quadrature counter Clock-A Clock-B

HSC1

Model Description I0.4 I0.6 I0.3 I0.2

0 Single-phase up/down counter with intemal
direction control
Direction control bit: SM47.3

Clock
1 Reset

3 Single-phase up/down counter with external
direction control Clock Direction

6 Dual-phase counter with up/down counting clock Clock
（decrease）

Clock
（increase）

9
AB phase quadrature counter Clock-A Clock-B

10 Reset

HSC2

Model Description I0.4 I0.5

0
Single-phase up/down counter with intemal
direction control
Direction control bit: SM57.3

Clock

9 AB phase quadrature counter Clock-B Clock-A

HSC3

Model Description I0.6 I0.7

0
Single-phase up/down counter with intemal
direction control
Direction control bit: SM127.3

Clock

9 AB phase quadrature counter Clock-B Clock-A
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2.2.7.4 High pulse speed output function

MK series PLC supports 4 high-speed pulse output channels, namely Q0.0, Q0.1, Q0.4, Q0.5, all channels
support PTO (pulse string, pulse + direction) and PWM output. At the same time, the software provides PLS (PWM
or PTO), positioning control instruction group, PFLO_F (follow instruction), etc., which is convenient for users to
realize simple motion control applications.
There are two ways to use a high-speed counter:
1.Programming with relevant instructions: This method requires setting coresponding control registers in the
program and calling the HDEF instruction and HSC instruction for programming. It is suitable for both
single-segment PV setting mode and multi-segment PV setting mode. For more detailed guidance, please refer to the
programming manual.

Figure 2.2.7-6 High speed counter instruction

2.Configuration with HSC wizard: This method is simple and intuitive, requiring only to check the settings provided

in the wizard. It is suitable for both single-segment PV setting mode and multi-segment PV setting mode.It is

recommended to use the wizard for setting, which is simple and convenient to save programming time.

Figure 2.2.7-7 High speed counter HSC wizard
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Hardware channel allocation

Model Definition Channel 0 Channel 1 Channel 2 Channel 3

PTO（Pulse train） Output Q0.0 Q0.1 Q0.4 Q0.5

PTO
（Pulse + direction）

Pulse output Q0.0 Q0.1 Q0.4 Q0.5

Direction output Q0.2 Q0.3 Q0.6 Q0.7

PWM Output Q0.0 Q0.1 Q0.4 Q0.5

2.2.7.5 Interrupt function

MK series PLC body input point I0.0 ~ I0.3 support edge interrupt function, can use the input signal rising edge

and falling edge to generate interrupt. This feature is fast enough to capture the rising or falling edge of the input,

and to achieve a fast response to some input signals whose pulse width is less than the CPU scan cycle. For more

detailed guidance and examples, please refer to the programming manual.

2.2.7.6 RS485

The MK series CPU all provide 2 channels of RS485, named PORT1 and PORT2. All channels are designed

with isolation in hardware to ensure stable and reliable communication operation.The supported protocols or

functionalities for RS485 ports are as follows (" √" indicate support, "-"indicate not support):
NO. Modbus RTU Programming&Debug Free communication

PORT1 √ √ √
PORT2 √ × √

Supports setting slave addresses from 1 to 127, with the default address being 1.

Supports baud rates ranging from 1200bps to 115200bps.

Supports master/slave mode.

Each channel can connect up to 32 devices.

2.2.8 CPU module technical specification

2.2.8.1 Power supply

Rated power supply DC24V，USB-Slave only supports power supply during program debugging
Supply voltage range DC20.4V~28.8V

Rated power 10W

2.2.8.2 DI

Input type NPN/PNP
Rated input voltage DC24V, maximum allowable DC30V
Rated input current 3.5mA@24VDC

Logic "0" maximum input voltage 5V@0.7mA

Logic "1" minimum input voltage 11V@2.5mA

Input delay time Turn-on delay: common channel 15μs, high-speed channel 10μs (50K)
Turn-off delay: common channel 60μs, high speed channel 6μs (50K)

Input and internal logic circuit isolation Photoelectric coupler 500VAC/1min

mailto:5V@0.7mA
mailto:11V@2.0mA
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2.2.8.3 DO( Transistor )

Input type PNP

Rated output voltage DC24V，allowance range: DC20.4V~DC28.8V

Output current / channel Rated 200mA@24VDC

Inrush transient current/channel 1A，≤1s
Output leakage current Max: 0.5μA
Output impedance Max: 0.2Ω

Output delay time Turn-on delay: common channel 15μs, high-speed channel 10μs (50K)
Turn-off delay: common channel 35μs, high speed channel 6μs (50K)

Protect function
Inductive load output protection

short-circuit protection
Output polarity reversal protection(≤10s)

Output and internal logic circuit isolation Photoelectric coupler 500VAC/1min

2.2.8.4 DO( Relay )

Output type Relay
Allowable load voltage DC 30V/AC250V
Allowable load current 2A（DC 30V/AC250V）
Output current /group Max: 6A

Output turn-on delay time Max: 8ms
Output turn-on delay time Max: 5ms
Expected contact lifespan

Mechanical lifespan（No load）
Electrical lifespan（Rated Load）

20,000,000 times (1200 times/min)
100,000 times （6 times/min）

Isolation characteristic Relay isolated
Coil and contact isolation voltage: 2000Vrms

2.2.8.5 AI

Signal type 4~20mA、1~5V、0~20mA、0~10V
Resolution 12 bits

Measuring accuracy 0.3% F.S.

Conversion rate（each channel） ≈200 times / s

Input impedance Current mode：≤250Ω
Voltage mode：＞4MΩ

Anti commonmode voltage (Signal voltage + common mode voltage) ≤15V,
Beyond the channel will be in the protection state.

2.2.8.6 AO

Signal type 4~20mA、1~5V、0~20mA、0~10V

Resolution（include signed bit） 12 bits

Output signal accuracy 0.3% F.S.

Conversion rate（each channel） ≈300 次/秒

External load Current mode：≤ 500Ω
Voltage mode：≥ 1kΩ
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2.2.8.7 Communication interface

Ethernet 1 channel, support HMI configuration program up/download, connect KDManager
firmware upgrade

DB9

2 channel RS485，isolation
Baud rate range：1200bps~115200bps
PORT1 supports programming protocol, Modbus RTUmaster/slave station, and free
communication
1 channel CAN，8 KS expansion modules can be connected

2.2.8.8 Program storage and RTC

User program Max: 4k instructions
User data M area: 1k byte V area: 4k byte

Timer

Total: 256
1ms time base：4
10ms time base：16
100ms time base：236

Counter 256

Tmer interruption 2 , 0.1ms time base

Data backup EEPROM，448K byte

Data retention
V area：VB0-VB1907，total 1908 bytes
C area：C0-C63
Lithium battery, 3 years at room temperature

RTC When the operating environment is at 25 ℃, the error is less than 5 minutes /month

Battery Support battery voltage monitoring, can replaceable battery

2.2.8.9 Display specification

Display size 7’’TFT 4.3’’TFT

Resolution 800*480 pixel 480*272 pixel

Display colour 256K colour

Brightness 250cd/m2
Bace light LED

Touch screen 4-wire, precision resistance network (surface hardness 4H)
LCD lifespan 50000 hours

CPU 700MHz RISC

Serial port No 1 * RS232 (COM2)
OnlyMK043E - 27 DT support

Ethernet 10M/100M adaptive

Memory 128MB Flash + 64MBDDR2

Formula memory 256K+RTC

Extendedmemory 1*USB-Host

Program download 1*USB-Slave/Ethernet/flash drive

Printer port USB-Host

Software Kinco DTools + EdgeAccess + Miot
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2.2.9 CPU power wiring diagram

2.2.9.1 DC power supply wiring diagram

Figure 2.2.9-1 power supply wiring diagram

Pin Meaning

24V 24VDC power supply positive end

0V 24VDC power supply negative end

FG Ground

After the module is powered on, the [PWR] indicator on the MK070E panelwill always on (green).

2.2.10 DI/O wiring diagram

2.2.10.1 Transistor type DI wiring diagram

Figure 2.2.10-1 DI wiring diagram

The CPU digital input supports NPN or PNP wiring. As shown in the figure above,when the signal flows into

the 1M , it is referred to as NPN input; when the signal flows out from the (1M), it is referred to as PNP input. In the

diagram, solid lines represent external wiring for PNP input, while dashed lines represent external wiring for NPN

input.This wiring diagram applies to all MK series input wiring

Pin Meaning Pin Meaning

1M
24VDC +（Source type） I0.2 Universal/high-speed input

24VDC -（Drain type） I0.3 Universal/high-speed input

I0.0 Universal/high-speed input I0.4 Universal/high-speed input

I0.1 Universal/high-speed input I0.5 Universal/high-speed input
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2.2.10.2 Transistor type DO wiring diagram

Figure 2.2.10-2 Transistor type DO wiring diagram

The CPU transistor-type output only support PNP type. PNP means that when a signal is triggered, the signal

outputs as high-level. in the diagram above, L- is connected to the DC 24V-，L+ is connected to the DC 24V+, and

the signal is connected to the external load.

This diagram applies to all MK series transistor type output wiring except MK070E-32DX and

MK070E-27DRT.

Pin Meaning Pin Meaning

L- 24VDC- Q0.2 Universal

L+ 24VDC+ Q0.3 Universal

Q0.0 Universal/high-speed output Q0.4 Universal/high-speed output

Q0.1 Universal/high-speed output *

2.2.10.3 Relay type DO wiring diagram

Figure 2.2.10-3 Relay type DO wiring diagram

In the diagram above, 2L is DO common terminal. Each common terminal can be connected to DC or AC

power supply as needed.When the current required by the load is large, two "2L" can be connected to the power

supply simultaneously to meet the requirements of the output load.

Note:

The relay output-type CPU modules do not support high-speed pulse output function.
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2.2.10.4 DIO wiring diagram

Figure 2.2.10-4 DIO wiring diagram

The figure above is DIO wiring diagram. Only the MK043E-27DT provides 4 channels of DIO, and each

channel can be used independently as DI or DO according to the connection method. The dashed line is the NPN

drain output and the solid line is the PNP source input.

Figure 2.2.10-5 shows the wiring diagram in source input mode using DIO1.5 channel as an example, and

Figure 2.2.10-6 shows wiring diagram in drain output mode.

Figure 2.2.10-5 Source input (DI) Figure 2.2.10-6 Drain output (DO)

2.2.11 AI/O wiring diagram

2.2.11.1 AI wiring diagram

MK070E-33DT and MK043E-27DT have two analog input channels (2*AI), support current input

(4-20mA/0-20mA) and voltage input (1-5V/0-10V), and the measurement accuracy is 0.3% F.S. The signal form and

filtering mode of the channel can be configured through KincoBuilder programming software, and each channel

allows mixed access to different signals. For the configuration method, see 4.3.2 KincoBuilder configuration

extension module.

Load
Load
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4-wire / 2-wire current input

Figure 2.2.11-1 2-wire / 4-wire current input wiring diagram

Current signal corresponding to access pin * + and R * (* indicate channel name: A/B/C/D), Taking the 2-wire

current input A group as an example, signal + end of the transmitter needs to be connected to the sampling resistance

"B+" of the channel,signal - end of the transmitter needs to be connected to the "A-" of the channel.

Taking the 4-wire current input B group as an example, it is necessary to connect the transmitter signal - end to

channel "B-", the transmitter signal + end to RB, and the transmitter power input is connected to the external power

supply.

Pin Meaning Pin Meaning

RA ChannelA sampling resistance RB Channel B sampling resistance

A+ ChannelA input signal positive B+ Channel B input signal positive

A- ChannelA input signal negative B- Channel B input signal negative

Voltage input

The positive and negative terminals of the voltage transmitter are corresponding to the access pins *+ and *- (*

indicates the channel name: A/B/C/D).

The MK043E-20DT has 2 analog input channels, each input channelconsisting of 2 terminals, named *+ and *-

(* indicates the channel name: A/B/C/D, Channel A is used as an example,the two terminals are A+ and A-and

support 0-10V input voltage). For details, see 4.3.2 KincoBuilder configuration extension module.

.

Figure 2.2.11-2 MK070E-33DT, MK043E-27DT voltage input wiring diagram

2 wire
transmitter

4 wire
transmitter
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Figure 2.2.11-3 MK043E-20DT voltage input wiring diagram

Thermal resistance input

The MK070E-27DRT has 3 thermal resistance input channels (3*RD), each input channel consists of 3

terminals, named X1, X2, X3, (X is the channel name: A/B/C/D, take channel A as an example, the three terminals

are A1, A2, A3), support Pt100 thermal resistor, 2-wire and 3-wire heating resistor. The filtering mode of each

channel can be configured in KincoBuilder programming software. For the configuration method, see 4.3.2

KincoBuilder configuration extension module.

If user use2-wire heating resistance measurement,refer to the wiring diagram of channel A in the following

figure . The connection of the heating resistor does not need to distinguish between positive and negative poles, after

connection, short-circuit terminals A2 and A3. If 3-wire heating resistance is used for measurement, refer to the

wiring diagram of channel B in the following figure.

It is recommended that the user short-circuit the unused channel group terminals, and set the corresponding

signal form of the group to [0-20mA] or [0-10V] in the programming software, artificially let the pin of this group of

channels in the signal acquisition state, and release the gathered charge in the form of short-circuit to prevent false

alarms caused by interference.C channel in the following figure is not in use, the three terminals of channel C can be

short circuited

Figure 2.2.11-4 Thermal resistance input wiring diagram

After the input signals of each channel are sampled by ADC and linearly calculated, the calculated results are

sent as measurement values through the expansion bus to the AI image area of the CPU module for user program

access. Different signal types have their own measurement ranges. If the measured value exceeds the rated

measurement range, the module will alarm : LED light of the channel that exceeds the range will light up (red)and
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the module will automatically send a fault message to the CPU module through the expansion bus.

The following table is the measurement range and measurement value format.

I : input current value V : input voltage value.

Signal type Measure range Measurement value representation format

Pt100 -200~850℃ T×10 (-2000~8500)
Cu50 -50~150℃ T×10 (-500~1500)
Pt1000 -50~300℃ T×10 (-500~3000)
Resistor 0~2000Ω R×10 (0~20000)

Thermocouple input

MK043E-20DTC has 2 thermocouple input channels (2 * TC) and supports J/K/E/T type thermocouple. It is

recommended that users short-circuit the unused channel group terminals. The B channel in the figure is the unused

channel, so short circuited B+and B - . KincoBuilder can be used to configure each channel to use any type of

thermocouple from J/K/E/T, measure cold end internal compensation, external compensation, and filtering methods.

The configuration method can be found in 4.3.2 KincoBuilder configuration extension module.

Figure 2.2.11-5 Thermocouple input wiring diagram

After the input signal of each channel is converted by A/D, the value obtained will be calculated and converted

according to the standard thermocouple calibration table, and the result will be sent to the AI area of the CPU module

through the expansion bus for user program access.

Different types of thermocouple has its corresponding measuring range, if the measured value is beyond the

rated range, the module will alarm. The following table shows the measurement range and measurement value

format（T: measured temperature value) .
Note:

Since the cold end temperature measuring element is installed inside the module, when using the internal

compensation method, the measurement results will be affected by the heating generated by the module during

operation. Normally, the measured value of the internal compensation method is about 2° C ~ 4 ° C higher than

the actual temperature.

Thermocouple type Measure range Measurement value representation format
J -100~1200℃ T×10（-1000~12000）
K -100~1300℃ T×10（-1000~13000）
E -80~1000℃ T×10（-800~10000）
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T -100~400℃ T×10（-1000~4000）

2.2.11.2 AO wiring diagram

Current/Voltage output

The MK070E-33DT and MK043E-27DT have 1 current/voltage output channel, and each channel consists of I,

V, and M. For the configuration method, see 4.3.2 KincoBuilder configuration extension module.

Figure 2.2.11-6 AO output wiring diagram

The analog output channels in the figure above support both current and voltage output modes. I, V, and M

correspond to the current output, voltage output, and common terminal respectively. Current type output correspond

to pin M and pin I, and voltage type output correspond to pin M and pin V.

When wiring, connect the analog output positive terminal (+) to the external device analog input positive

terminal , and connect the analog output negative terminal to the external device analog output negative terminal.

2.2.11.3 Analog measurement range and measurement value representation format

After the input signals of each channel are sampled by ADC and linearly calculated, the calculated results are

sent as measurement values through the expansion bus to the AI image area of the CPU module for user program

access. Different signal types have their own measurement ranges. If the measured value exceeds the rated

measurement range, the module will alarm.

It is recommended that the user short-circuit the unused channel group terminals, and set the corresponding

signal form of the group to [0-20mA] or [0-10V] in the programming software, artificially let the pin of this group of

channels in the signal acquisition state, and release the gathered charge in the form of short-circuit to prevent false

alarms caused by interference.

The following table is the measurement range and measurement value format.

I : input current value V : input voltage value.

Thermocouple type Measure range Measurement value representation format

4~20mA 3.92~20.4mA I×1000（3920~20400）

0~20mA 0~20.4mA I×1000（0~20400）

1~5V 0.96~5.1V V×1000（960~5100）

0~10V 0~10.2V V×1000（0~10200）

The AQ output value specified in the user program is first sent to the corresponding AO module through the

expansion bus, and then calculated, transformed, and output to the specified channel through DAC. The output of

different signal form have its rated range. If the specified output value in the user program exceeds the upper and
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lower limits of the selected range, the corresponding values of the upper and lower limits will be output.

The following table is the output range and output value representation format.

I : actual current value V : actual voltage value.

Signal type Output range Output value specified in the user program

4~20mA 3.92~20.4mA I×1000（3920~20400）

0~20mA 0~20.4mA I×1000（0~20400）

1~5V 0.96~5.1V V×1000（960~5100）

0~10V 0~10.2V V×1000（0~10200）

2.2.12 MK series product wiring summary

Figure 2.2.12-1 MK043E-20DTC wiring diagram Figure 2.2.12-2 MK043E-20DT wiring diagram
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Figure 2.2.12-3 MK043E-27DT wiring diagram
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Figure 2.2.12-4 MK070E-27DRT wiring diagram Figure 2.2.12-5 MK070E-32DX wiring diagram
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Figure 2.2.12-6 MK070E-33DT wiring diagram
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Figure 2.2.12-7 MK070C-33DT wiring diagram
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Figure 2.2.12-8 MK043C-20DT wiring diagram

2.2.13 MK series product dimension

Figure 2.2.13-1 MK070E-33DT/32DX/27DRT,MK070C-33DT dimension
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Figure 2.2.13-2 MK043E-20DT/20DTC, MK043C-20DT dimension

Figure 2.2.13-3 MK043E-27DT dimension
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3 Installation guideline

3.1 MK series product connect expansion module

The standard MK series product support up to 8 KS expansion modules. CAN communication protocol is used

between the MK and the expansion module. However, the CAN communication physical interface and two RS485

communication physical interfaces of the MK are placed in the DB9 connector. The physical CAN communication

interface of the KS expansion module is an RJ45 connector. Therefore, if the MK wants to connect the first KS

expansion module,user need to prepare a DB9-RJ45 communication cable.

The pin definition and connection relationship of CAN communication protocol in different connectors are

shown in the following table.
MK: DB9 connector KS expansion module :RJ45 Definition

PIN7 PIN1 CAN_H
PIN2 PIN 2 CAN_L
PIN5 PIN 3 CAN_GND

At the top of the KS expansion module, there are two RJ45 interfaces, EXT. OUT and EXT.IN, which can be

distinguished by the information stickers on the front of the module. Connect the RJ45 interface of the DB9-RJ45

cable to the EXT. IN of the first expansion module. Connect EXT.OUT of the first expansion module to EXT.IN of

the second expansion module using a network cable, repeat this process to connect the expansion modules. Taking

the example of connecting the first expansion module KS133-06IV to the second expansion module KS131-04RD in

the following figure

Figure 3.1-1 KS connection method of the expansion module

After the hardware connection is correct, you need to configure the KincoBuilder software to use the module

function. For details, see 4.3.2 KincoBuilder configuration extension module.
Note:

Before connecting the expansion module, confirm EXT.IN and EXT.OUT.,which can be used when the connection

is correct.

Please ensure that the expansion cable is securely plugged in, otherwise it may cause poor contact and system

communication failure.
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3.2 Dis/Assembly of terminal blocks

3.2.1 Disassembly of terminal blocks

Hold the protruding parts on both sides of the top of the terminal block, and apply vertical force to pull out the

terminal block.

Figure 3.2.1-1 MK terminal block

Figure 3.2.1-2 MK terminal block disassembly operation diagram

3.2.2 Assembly of terminal blocks

1.Align the protruding positioning teeth at the tail of the terminal block with the terminal slot

Figure 3.2.2-1 Terminal block assembly diagram1

2.Press down firmly into the terminal block until it fits into the terminal slot

Figure 3.2.2-2 Terminal block assembly diagram2
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3.3 Installation method

The packaging box of the MK series product contains a sealed pocket with fixed accessories, which contains 4

installation buckles and screws. The MK070E has square mounting slots on the upper, lower, left and right sides. In

the KincoDTools software, MK supports editing the configuration screen in a vertical or horizontal posture. Users

can choose to install the installation buckles on the top and bottom sides or left and right sides according to their

needs.

Figure 3.3-1 MK043E packaging box-fixed accessory

Figure 3.3-2 MK070E packaging box-fixed accessory

Figure 3.3-3 MK installation buckles
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Figure 3.3-4 Install the fixed accessories on the upper and lower sides

Figure 3.3-5 Install the fixed accessories on the left and right sides

The installation steps are as follows:

Place the MK into the installation holes on the device control panel, and clamp the installation buckle hook into

the square installation slots on the upper and lower sides or left and right sides as needed.

Tighten the screw clockwise with a recommended torque of 0.5N·m to achieve waterproof and dust-proof effect

and avoid shell deformation.

Figure 3.3-6 Fixed accessories installation diagram
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4 Getting started with Kinco Builder

KincoBuilder is a programming software for Kinco K-series PLC, compliant with the lEC61131-3 standard,

enabling users to carry out efficient program development. Here is a brief getting started guide to assist users in

quickly getting acquainted with KincoBuilder.

4.1 Software interface introduction

Figure 4.1-1 KincoBuilder interface overvie

Num. Item Description

① Menu bar The Project menu contains all the operational commands ofthe KincoBuilder.

② Toolbar The Toolbar contains some frequently used operational commands.

③
Variable definition

area For variables declaration

④ Programming area For program editing ,the LD editor or IL editor can be chosen optical

⑤

Project
management area

The Prject manager is one of the main windows in the interface, which
intuitively links all components of the current project in a tree structure,
induding programs, hardware(configurations), status chart, global
variable(tables). etc.Users can manage, operate, and maintain the current open
project in this device tree. Each node in the project manager supports
right-click operations to pop up corresponding windows.

⑥ Output

Information window, is used to display various prompts of the KincoBuilder.
The "Compile" window shows the compilation information of the user's last
compilation. The “general information” window displays a information of
some recent actions.

⑦ Status Display Bar The status bar is used to display the current status of the software and
prompts for operational commands.
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KincoBuilder has organized some commonly used functions into sections on the toolbar for user convenience.

Hovering the mouse pointer over the corresponding icons allows to view brief descriptions of the functions and their

corresponding shortcut key operations. For more detailed information, please refer to the relevant application

manual.

4.2 Create a New Project

There are two ways to create a new project in KincoBuilder. First, double-click the KincoBuilder icon to

open the software. The following image shows the initial interface after opening the software.

Figure 4.2-1 KincoBuilder initial interface

User can create a new project by selecting [New Project...] under the [File] menu in the menu bar. Alternatively,

you can quickly create a new project by clicking the [Create a new project] on the toolbar.

Figure 4.2-2 New project path

In the pop-up [New Project...] dialog box, select the location to save the project, modify the project name and

then click "Save" to complete the creation.
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4.3 Hardware configuration

4.3.1 Configure the CPU

After a new project is created, the program will set the CPU to K606-24DT by default. The user needs to

modify the CPU according to the actual hardware model. The default configuration model of the new project can

also be opened by [Tools]→[Options] on the menu bar. Select the desired CPU model from the Default CPU model

drop-down list under Default Project Properties and click Apply to save the settings.

Here's an example for how to configure the MK070E-33DT. In KincoBuilder,User can find [Hardware] in the

left device tree and double-click to open it. User can also click the "Open hardware configuration " button on the

menu bar to open the hardware configuration interface.

Figure 4.3.1-1 Hardware configuration interface

After opening the [Hardware] interface, the first row displayed in the hardware configuration list is indeed the

currently configured CPU. When changing the configuration, you need to delete the module configured

(Right-clicking on the module name to delete the configured module). Then, in the [HW Catalog], find the

MK070E-33DT , and double-click to automatically add it to the project.

Figure 4.3.1-2 Delete module

Figure 4.3.1-3 Configure MK070E-33DT
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I/O , Comm,Reten, CANop , and more can be performed on the Hardware interface. For more detailed

configuration tutorials, please refer to the software user manual.

Figure 4.3.1-4 MK070E-33DT configuration interface

4.3.2 Configure the expansion module

After the correct connection of the expansion module , its expansion function needs to be configured through

KincoBuilder software before it can be really used. The specific steps to enable the expansion module on the

software are as follows: [Hardware]→[HW catalog]→[KS/KW ]→[Digital module]/[Analog module], select the

expansion module and double-click to add it.

Figure 4.3.2-1 Add enpansion module
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If you need to set the expansion module, click the corresponding module model to open the related setting

interface.

Figure 4.3.2-2 Enpansion module configuration
Note:

In KincoBuilder, the configuration order of expansion modules must match the actual hardware connection

sequence. Otherwise, it may cause errors in the PLC.

4.4 Programming simplified guide

4.4.1 On-line Help

In KincoBuilder software built-in more detailed instructions, the user can click on the toolbar [Help] →

[Contents and Index] to open the online-help interface to find programming instructions quickly.

Figure 4.4.1-1 Help interface

In the left navigation bar, it supports finding detailed instructions through browsing the directory, keyword

indexing, and searching. It also supports adding the found information to the favorites folder.
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Figure 4.4.1-2 KincoBuilder help interface

4.4.2 Programming language

KincoBuilder supports programming using IL (Instruction List) language and LD (Ladder Diagram) language.

You can switch between these languages in the software by accessing the toolbar and selecting [Project].

Figure 4.4.2-1 KincoBuilder help interface

4.4.3 Programming instructions

This section does not introduce the specific usage of programming instructions. It only explains how to quickly

obtain help and instructions for programming instructions:

1. After selecting a specific instruction in the edited program, press the F1 shortcut key, then will automatically

open the online help and navigate to the corresponding instruction's explanation.



MK series integrated(PLC+HMI) user manual

51

Figure 4.4.3-1 MOVE instruction description interface

Figure 4.4.3-2 User manual

2.To find the usage of the corresponding instructions through the software manual. Please download the

software user manual from the official Steps website. Product version iterations may lead to some lag in both the

software and its user manual. Please ensure to download the latest version of the software and the corresponding user

manual from the official website promptly. （https://en.kinco.cn/download/plc87.html）

4.5 Compiler and Simulator

4.5.1 Compiler

The PLC compiler will verify all instructions supported by the actual PLC and the structure of user programs.

All errors in the KincoBuilder compiler will be listed in the [Output] window. Double-clicking on error messages

listed in the [Output] window will automatically locate the error.

The program can be compiled by clicking [Project] → [Compile All] on the toolbar, or by using the [F7]

shortcut key.After successful compilation, the number of generated instructions will be displayed.

https://en.kinco.cn/download/plc87.html
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Figure 4.5.1-1 Compile path

4.5.2 Simulator

In KincoBuilder, an offline simulator for KPLC is provided, supporting simulation of actual program execution

and debugging of user programs while offline. The simulator offers practical debugging features such as breakpoints,

single-step execution, single-network execution, pause/resume operation, and serial communication simulation.

Figure 4.5.2-1 Start simulator

Run continuously:After the simulator is started, it performs cyclic scanning and execution of the program.

Pause at the first network:After the simulator is started, it stops executing after completing the first scan cycle.
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Figure 4.5.2-2 Simulator interface
NO. Item Description

① Toggle monitoring mode Click to enter or exit monitoring mode

② Enter/Exit simulation mode
Click to enter offline simulation mode.

Click to exit offline simulation mode.

③
Function shortcuts for
offline debugging

Restart the simulation.

Stop the program execution.

Continual the program execution

Adjust the scan cycle of simulation

Execute an instruction

Execute a network

Execute to the network where cursor(line)

Add/remove the breakpoint

Disable/enable the breakpoint

Disable all breakpoint

Enable all breakpoint

④ Debug program

The [Debug program] window includes features such as:
Current status display
Execution of scan cycles(executed)
Program network display(current)
Jump to the next network
Execute the specified scan cycles

⑤ I/O channels
Input or output signals can be simulated by checking the corresponding IO
channel option.

⑥ Communication simulator
Suitable for simple communication simulation debugging of XMT RCV
commands

⑦ Programming Area
This area allows the user to observe the program running and debug the
program manually
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4.6 Connection and program up/download

4.6.1 MK series PLC communicate with PC via USB-Slave

User need to use a USB-B programming cable to connect the PC and MK . The DB9 port on the back of the

MK has two RS485 ports, and only Port1 supports the programming protocol and power on the PLC.

In this example, the serial port number being used is COM3. Select [Use COM Port] in Communications and

modify the [Port] to match the actual port number. (please confirm the actual COM port through the PC's Device

Manager)

Figure 4.6.1-1 COM port setting

Click on [Start] to scan for device. After successful recognition, the [Local Parameters]in KincoBuilder will

automatically correspond to the actual parameters. Finally, click " OK" to complete the connection.

Figure 4.6.1-2 COM port scan
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4.6.2 Program upload/download

KincoBuilder provides two ways to upload the program: [Upload] and [Upload (breakpoint resume)...].

Breakpoint transfer refers to the ability to resume transmission from the point where it was interrupted or failed

during the file transfer process. This way allows file transfers to be completed efficiently even if the network is

unstable or the transfer process is interrupted. Therefore, in situations where the network is busy, long-distance

transmission, or for large project sizes, it is recommended to use [Upload breakpoint resume)...] for program

uploading. On the contrary, [Upload] is a one-time transfer, if any error or interruption occurs during the program

transfer, KincoBuilder will interrupt the uploading process directly and return an error, requiring the user to

re-trigger the upload operation and start the transfer from the beginning

Figure 4.6.2-1 Program upload trigger path

The process for program uploading is as follows: Before initiating the upload operation, please ensure that

communication between the PC and PLC is functioning properly. Open the upload window by [PLC] → [Upload]

or [Upload(breakpoint resume)...] from the menu bar. Once the upload is complete, a window for selecting the save

path will pop-up. Choose the target save path and click OK. After the upload is finished, the uploaded project will

automatically open.

Figure 4.6.2-2 Program upload process
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KincoBuilder offers two methods of program downloading: [Download] and [Download (breakpoint resume)...].

Similarly(refer to Program Upload), when the program download process is frequently interrupted, the network is

busy, long-distance transmission is required, or for large project sizes, it is recommended to use [Download

(breakpoint resume)...] for downloading programs.

Figure 4.6.2-3 Program download trigger path

The process for program downloading is as follows: Before initiating the download operation, please ensure

that communication between the PC and PLC is functioning properly. Open the download window by selecting

[PLC] → [Download] from the menu bar or by using the shortcut key [F8]. Prior to the start of the download

process, KincoBuilder will automatically compile the current project, and relevant information will be displayed in

the [Compile] window. After successful compiling, clicking [Download] , then will trigger the download process

normally. Upon completion of the download, there will be a prompt in the [Output] window, displaying information

such as the software version and model of the current device.

Figure 4.6.2-4 Output window
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Option Description

Set the CPU to “ Upload Disabled”
Enabling this option will encrypt and store all user programs in the PLC, and "Upload program"

will not be supported. Please be careful when enabling this option and take care of program backup

Clear the Retentive Ranges inV

area after downloading

Enabling this option will clear all data in the V-area and C-area of the Data Maintain after

program downloading, while disabling it will have no effect.

Clear the Permanent Backup

Ranges after downloading

Enabling this option will clear all data in the Permanent Storage after program downloading,

while disabling it will have no effect

Not automatically compiled before

downloading ormonitoring(not

recommend)

Enabling this option will prevent automatic compilation after clicking "Download" or "Toggles

Monitroing Mode(F6)" in this session, which may lead to abnormal program execution or

monitoring. This may not be conducive to program troubleshooting and monitoring. Please be

careful when enabling this option. This setting is only valid for the current session and needs to

be re-enabled after restarting KincoBuilder.

4.7 Error message and solution

4.7.1 Error Message in KincoBulider

Before viewing the PLC error message, please make sure that the PLC and PC are communicating normally,

otherwise, please refer to "Conneted to PC" for connection

Figure 4.7.1-1 PLC error message query path

4.7.2 Common Error

The error message consists of an error code and a description of the message. The following are common error

codes encountered by users during initial use, along with their corresponding solutions.
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Error code Description Solution

20 The PLC in "Hardware" does not match the
actual connectedCPU.

This error is generally due to a mismatch between the PLC being
used and the PLC configured in KincoBuilder. Please check and
correct the settings in the "Hardware" section

21 There are errors in the "Hardware"
configuration for the expansionmodules.

First check whether the order of adding modules in [Hardware] is
consistent with the actual connection order, and then check whether the
added modules match the actual modules.

29
Unknown instructions are detected in the
PLC program during power-on.

This error usually due to the firmware version does not match the
programming version. When KincoBuilder updates, it may modify
certain instructions, and new instructions and features require compatible
software and firmware. Please check the current KincoBuilder and
firmware versions. New software can be obtained from the official
Kinco website, while PLC firmware can be obtained by contacting
Kinco's technical support or local service centers.

If you need more detailed explanations of error codes, please open the Online Help or download the "Kinco-K

Series Application Manual" from the official website.

4.8 Firmware update

KincoBuilder comes with a firmware update program, users can connect the PLC through the KincoBuilder to

update the firmware of the PLC: [Tools] → [PLC Firmware Upgrade(Common)...].

Figure 4.8-1 PLC Firmware Upgrade

Open the firmware update program will pop up the update operation prompt page, as shown in the following

figure:
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Figure 4.8-2 Program update interface

The method of entering the system update mode varies depending on the PLC product.

Before starting the firmware update, read the [Help] instructions on the [Upgrade Firmware for Kinco KPLC]

carefully. The specific update procedures are listed on the left side of the pop-up window. Please follow the

instructions according to your model.

Figure 4.8-3 Help document description

The steps for updating the firmware of MK series PLC using the USB-Slave are as follows:
1. Use the USB-B cable to connect the PLC to the PC via USB port and power up the PLC.
2. Click on [Communiactions...] to configure the communication parameters.

*Taking COM6 as an example, the actual selection of the COM port needs to be based on the COM port displayed in
the device manager of the computer control panel.
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*The station address must be 1.
3.Click on [Select Firmware File...] and choose the target file and then click "OK".
ps: If the selected file is valid, the "File Information" section will display the applicable PLC mode, hardware
version, and firmware version.
4. Click on the [Enter Upgrade Mode]. After about 2 seconds, the "Run" light on the PLC panel will flash rapidly,
indicating that the PLC has successfully entered system update mode.
5. Click on the [Start Upgrading] to initiate the system update for the PLC. The update process includes erasing the
PLC's FLASH data, writing new data, and verifying the written data.
The "Operation Information Prompt" at the bottom of the window will display the ongoing operations and progress.
If there are any errors, they will be listed along with the error reasons.
6. After receiving a successful update prompt, restart the PLC to ensure it automatically loads and runs the new
firmware program.
Solution for Firmware Update Failure:

If encounter an error message indicating a failed update during the process, and the PLC [Run] light is

continuously flashing, then try repeatedly clicking on [Start Upgrading]. If, after restarting the PLC following a

failed update, the PLC can be connected but cannot enter the update mode, try power off the PLC for a while before

update again.

If firmware update still cannot be performed, please check the [Run] light, battery level, and firmware version,

and then contact Kinco Technology Support or local agents for assistance
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5 Getting started with KincoDTools

KincoDTools configuration editing software is a special human-machine interface configuration editing

software developed by Kinco for Green series and Future HMI.

The software installation process and configuration requirements are omitted here. This document only

provides brief operations to get you started. For details about how to use KincoDTools, see 5.4.2 KincoDTools User

Manual.

5.1 KincoDTools create new project

There are two ways to create a project in KincoDTools. First, double-click the KincoBuilder icon to open

the software. The following picture shows the initial interface after opening the software:

Figure 5.1-1 KincoDTools initial interface
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5.1.1 Initial interface function description

Figure 5.1-2 KincoDTools interface description

Num. Project Description

① Menu bar The menu contains all the operation commands of KincoDTools software.
② Tool bar The Toolbar contains some frequently used operational commands.

③ Status display
The status bar provides the current software status information and
prompts for toolbar operation commands.

④ Component library window

There are three device pages: Connector, HMI, and PLC. Hold down the
desired device and drag it to the device topology window to add the
device. Click to view the device information.
Connector page: Contains commonly used communication connection
cable
HMI page：Contains all HMI models of Kinco

PLC page：Support other manufacturers PLC equipment except Kinco
Details of the relevant connection settings can be found in
[Communication Connection Help (C)] in the menu bar [Help (H)].

⑤ Device topology window Display the topology connection screen of the added devices.

⑥ Project structure window

There are two information pages for project tree and address browsing.
Project tree：After the project is successfully created, the library file,
HMI, PLC information of the project file is displayed.
Address browsing：It can display the address usage of HMI and PLC
register and the use location, name and corresponding data in the project.

⑦
Compile information

window
Displays project status and compilation information.

⑧ Mouse coordinate display Assist users to set X and Y axis parameters when using window elements.

User can create a new project by selecting [File]→[New (N)]. Alternatively, you can also create a new project
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by directly clicking the [New Project] button on the toolbar

Figure 5.1-3 Create new file

Then in the pop-up [New project] dialog box set the project name, select the project save location, HMI series

and HMI model, here to create a project name of "Test_1" MK070E project as an example.

Figure 5.1-4 New project dialog box
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Figure 5.1-5 Set the project name “Test_1”

Figure 5.1-6 Change the project path

In the KincoDTools software, the MKseries can edit the configuration screen in a vertical or horizontal attitude.

User can select horizontal or vertical in the Display mode. If this parameter is incorrect, you can modify it after the

project is created. For details, see 5.2.1 Add/Delete HMI

Figure 5.1-7 Display mode
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Figure 5.1-8 Set HMI model

After setting, click [Next >>] to complete the project creation.

5.2 KincoDTools system parameters set

After the project is created, the system parameters set page is displayed. On the page, you can change the HMI

type, set the network IP address, and add network port or serial port device parameter setting.
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Figure 5.2-1 System parameter setting interface

5.2.1 Add/Delete HMI

If the user selects the wrong HMI model and display mode in the [New Project ] step, they can add the correct

HMI model in the [System Parameter Set] interface.

The operation steps are as follows: select the device [NO.]→ click [Delete]→ Select [Y] in the pop-up prompt

box → Click the [▼] button in the column of HMI Type → Select the correct model in the HMI model list →

Select the display mode in the same way if necessary → click [Add], users can add multiple HMI devices.Taking

the replacement of MK070E with MK043E as an example.

Figure 5.2-2 Modify HMI model

5.2.2 Network device and serial port setting

Network device setting

User need to set the IP address of the HMI through the network configuration, so that the PC can download the

HMI configuration program and other network port communication devices can connect to the HMI. The network IP

address can be set in the [System Parameter Set] interface. Click [Network Device Setting]→ Click [Add] in the

pop-up window. In the new pop-up window, there are three parameters that can be modified: Device NO. , IP

Address, and Comm Protocol.

 Device NO. : HMI0 corresponds to the HMI with serial number 0. If the user has added multiple HMI devices,

they can switch to the corresponding devices for settings;

 IPAddress: The modification here is the IP address of the HMI device which selected for the Device NO.

 Comm Protocol:The default is Kinco communication protocol. If users need to connect other devices, they can

select the protocol of the corresponding manufacturer from the list called by the [▼]
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Figure 5.2-3 Network device setting

Select the default Kinco communication protocol here, set the IP address of the corresponding device, and click

[OK]. In the figure, change IP address to 192.168.0.150 as an example, click [OK], then check the IP address and

communication protocol corresponding to the HMI device number, and click [OK] again. The IP address of HMI

network port 0 is successfully changed to 192.168.0.150.

Figure 5.2-4 IP adress setting

Serial port setting

Serial port 0 parameter setting is an important action to connect the MK series PLC and HMI . Click [COM0],

select the manufacturer [Kinco], select the communication protocol [Kinco PLC Series], click [Add] after selecting,

and finally select [Finish]. You can observe that the device topology on the engineering page has changed.
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Figure 5.2-5 COM0 setting

Figure 5.2-6 Finish COM0 setting

Figure 5.2-7 Device topology window
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5.3 Startup menu

Hold pressing on the touch panel when you power on HMI, then HMI will enter operation mode selection

window, select the operation mode according to your application.The following function buttons are displayed on the

startup menu:

System setup:Press this button to enter system setup window. This window is used to set the startup animation,

screen saver time, buzzer sound, brightness adjustment, system time, initial window, and IP address .After setting,

press Restart button to restart HMI.

Firmware Update: Press this button to enter firmware update mode. This window is used to updatefirmware.

Normally this mode is not advised to use without guiding by manufacturer.

Touch calibration：If the screen touch is not accurate after updating the firmware version, the user can calibrate the

HMI screen in this mode
Stop timer:After entering the operation mode selection screen, the countdown clock starts automatically. If no
operation is performed within 20 seconds of entering the operation mode selection screen, the system automatically
restarts and enters the engineering screen. If you are worried that the 20s event is too short to operate, you can click
this button to stop the countdown and keep the MK in the startup menu interface.

5.4 Configuration Editor

5.4.1 Configuration editor window

The device topology window shows the communication connection of the MK. If you want to draw the

configuration interface to control the connected device, you need to enter the configuration editing window. The

operation steps are as follows: click the menu bar [Window (W)], and click the drop-down menu bar [HMI Edit

Window (E)].

Figure 5.4-1 Enter HMI Edit window
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After successfully entering the HMI Edit window, you will see the following interface:

Figure 5.4-2 HMI Edit interface

Num. Project Description

① Toolbar The Toolbar contains some frequently used operational commands.

② Graph elepment
window

There are three pages of PLC Parts, Functional Parts and Project database.
PLC Parts:This page is mainly for control and display components,
write/read address can be set to HMI or PLC address;
Functional Parts：This page is for specific functional components;
Project database:This page component is used by double-clicking to store
engineering data information

③ HMI configuration
window

The white part with a dot matrix is the displayable part of the MK. All
configuration components can only be drawn in this area. The user can adjust
the size of this area by Ctrl+ mouse wheel.

④ Project structure
window

There are two information pages for Project Tree View and Address
browsing.
Project Tree View : After the project is successfully created, the library file,
HMI, PLC information of the project file is displayed.
Address browsing：It can display the address usage of HMI and PLC register
and the use location, name and corresponding data in the project.

5.4.2 KincoDTools user manual

This manual is only a brief introduction. If user need to know the usage of a specific component or function,

click on the menu bar [Help (H)], find [User Manual (M)], and click to open the KincoDTools user manual
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Figure 5.4-3 Open user manual

5.4.3 Add component

KincoDTools has two ways to add components:

(1) Click [Components(I)] on the menu bar, hover the mouse over the component category to find the desired

component, and click Add;

(2) Find the desired component in the Graph element window, press the icon with the mouse and drag it to the HMI

configuration window to complete the addition.

Components in the Project database page can be added by double-clicking the component icon, or clicking [Lib (L)]

in the menu bar, and then clicking the desired library. For details, see 5.4.2 KincoDTools user manual

Take the Bit State Switch of adding PLC parts page as an example.

Figure 5.4-4 Add component method
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Figure 5.4-5 Add library method

After adding the component, a component property setting window will pop up. There are multiple subpages in

the component property setting window for setting. We take the example of creating a startup button with address

M0.0.
Basic Attributes: Set the object and address type related properties for component operations
Bit State Switch : Set the Switch Type, execution mode, and output mode.
Tag: Set the tag contentt displayed for each state of the component
Graphics:Set button in different states to display graphics, support import images
Control Setting:Set the operating conditions and operating time of the component, and set the function of trigger
macro execution or trigger register
Display Setting:Set the display condition of the component and the size and position of the component
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Figure 5.4-6 Set element adress type

Figure 5.4-7 Set Switch type and Tag

Figure 5.4-8 Set Graphics

After the setting is complete, click [OK] to complete the button creation. If you want to modify the setting after

the component is created, you can double-click the created component to call the properties setting window.
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Figure 5.4-9 Successfully created bit state switch

5.4.4 Add frame

KincoDTools allows to create up to 32768 frame, which are numbered from 0 to 32767 and displayed as

[Window number: Window name] in the project tree view. Users can click the menu bar [Screen (P)], click [Add

Frame (N)], set the window information in the new window property page to add.

Figure 5.4-10 Frame Position information

The created [10:CW] can be seen in the project tree view. Click and jump to this window for configuration

screen editing.



MK series integrated(PLC+HMI) user manual

75

Figure 5.4-11Add new frame successfully

5.5 Macro

5.5.1 Create macro file

If the components provided by the component window attribute cannot meet the specific needs of users, it can

be realized by creating macro code in C language. Click [Macromode... (M)] in the menu bar [Lib (L)], set the

macro file name and corresponding group number to create macro file. Macro files are divided into three groups 0-2

in the projectt tree view for management , which is convenient for user to distinguish macro files of different control

devices.

Figure 5.5-1 Crate micro file

Figure 5.5-2 Micro interface
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5.5.2 Add variable

Click the right mouse button in the [Parameters] window, click [Add Variable], set the variable name, data

type, variable address and R/W properties, click [OK] to create a variable.

Figure 5.5-3 Create variable

Figure 5.5-4 Add variable successfully

5.5.3 Macro file compilation and use

After the macro file is written, it must be compiled and the compiled result is correct before it can be used. User

can click the right mouse button in the [Macro operation window] or in the [Parameters] to find [Compile Macro],

click to compile.

The compilation result can be viewed in the Message window.
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Figure 5.5-5 Add variable successfully

Users can choose to use timer or function key buttons to execute macro code, and can find them on the

[Function Parts] page in the [Graph element window].The difference between the two is that the timer element is

triggered without button, and the macro code is executed when the execution conditions are met. The triggering

mode, execution period, response mode, and repetition times can be set, and the timer element can be placed in the

conditional triggering window or the public window(public window is always displayed on other window. For

details, see 5.4.4 Add frame). The function key element is triggered by the button and executes the corresponding

macro file by pressing the button.

Figure 5.5-6 Set Timer
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Figure 5.5-7 Set Function key

5.6 Offline Simulation

After completing the editing of the engineering configuration, it needs to be compiled before it can be

downloaded and simulated. "Offline Simulation" function can simulate the effect of the engineering configuration

runningand without connecting to the MK, eliminating download the engineering to the MK for verification every

time changes are made, greatly improving programming efficiency.

In the menu bar [Tools (T)], you can find [Compile All (R)] and [Offline Simulation (F)]. The current version

directly selects offline simulation to automatically compile, but it is still recommended that users develop the habit of

compiling the project before offline simulation. Select the HMI to be simulated in the pop-up dialog box, and then

click [Simulate] to enter the offline simulation running screen. Click the button in the screen to view the operation

effect of the project.

The remaining two simulation methods need to be performed with a connected MK, and users can choose

according to their needs.

Indirect Online Simulation:User need to connect the PLC and HMI, you can get dynamic PLC data, the

operating environment is the same as after downloading, there is no need to repeatedly download the project to the

HMI
Direct Online Simulation:User need to connect the PLC, you can get dynamic PLC data. In the absence of

HMI, it can be used to check whether the communication is normal.
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Figure 5.6-1 Creat simulation

Figure 5.6-2 Simulation button

Figure 5.6-3 Offline simulation operation effect

5.7 Special register function

HMI provides special registers to complete specific functions, tick [System Register] on the component

attribute page, then click [▼] at the end of the address type , open the address detailed Info page to view, select and
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search the special register address function, double-click to use the required special register, and click [OK] to

complete the creation.

For complete system register addresses and functions, refer to section 18.2 HMI System Special Registers in the

KincoDTools User Manual.

Figure 5.7-1 Set the system register

5.8 IOT function

MK series supports the IOT function, users can see the current supported IOT implementation method in the

menu bar [IOT (I)]. For detail , see KincoDTools user manual Chapter 17 .

Figure 5.8-1 IOT function

5.9 Project download

5.9.1 Compile & Download

If the offline simulation results of the project are correct, the project can be downloaded to the MK . Before

downloading, the project also needs to be compiled and the compilation results are correct. Click [Tools (T)],



MK series integrated(PLC+HMI) user manual

81

[Compile All (R)] on the menu bar, the Meaaage window displays the editing result is complete, click [Download

(D)], in the pop-up download setting dialog box to confirm whether the current communication mode is correct, user

can click [Set] to modify the communication mode. Select the required options in the column of [Select Section] ,

and finally click [Download] to complete the download operation.

Figure 5.9-1 Compile location

Figure 5.9-2 Building project
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Figure 5.9-3 Compiler result

Figure 5.9-4 Communication Set

Figure 5.9-5 Select Section
Name Description
Data file Download project files in .pkg , .pkgx format
Recipe file Download recipe files in .rep fommat
Logo file Download Initial Start Window in *.bmp/*.jpg/*.gif/*.logo format

Clear recipe Clear recipe data saved in RB/RBI/RW/RWI
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Clear history event data Clear the record in [Event Display】/ [Historical Event Display】 parts

Clear history record data Clear the record in [Historical Event Display】/【Trend Curve】/【Tend Curve】 parts

Clear data report Clear data saved in 【Data Report】 parts
Clear ERW data Clear the data saved in extemal register ERW/ERWI
Clear FRW data Clear the data saved in FLASH register FRB/FRBI/FRW/FRWI

Download to UsB 1 Download the prject files to extemal register USBl
Download to UsB 2 Download the prject files to extemal register USB2
Download to SD Download the prjeet files to extemal register SD

Resume To Default Setting Recovered the data above LW10000, Default check
PC synchronization time Synchronize PC time to the MK

Update IP after download Update the current network Port and port number of the HMI to the configured IP
address and port

Timeout Set the timeout time of download, the unit is millisecond, and it ranges from 0 to
65535

5.9.2 Flash drive download PLC program

MK supports the USB-host connection USB flash drive (must be FAT32 format USB flash drive) to update the

PLC program function. User need to download KincoDTools V4.3.0.2 or later to update the firmware. If the MK is

delivered, consult the technical department to obtain the software patch package to update the firmware. (Note: After

the patch is replaced, the functions are downloaded and updated along with the HMI project. Please recompile the

HMI project and download it, otherwise the patch will not take effect).

USB flash drive download PLC program operation steps are as follows:

Power on the device by long pressing the screen with two fingers, the device will enter the setting background,

enter the [System Settings] interface, click the [File Manager] page and click [PLC Project Download], the

following three project download options will pop up:

Figure 5.9-6 Download interface
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Project Description

The currenty downloaded user project is
prohibited from uploading

After this option is checked, all user programs stored by the PLC will
be encrypted and stored in ciphertext, and the "upload" operation is not
supported. Please check with caution and pay attention to program
backup.

Clear permanent data backup area after
downloading

After this option is checked, all data in the permanent data backup area
will be cleared after this download. If not, the data in the permanent
data backup area will remain unchanged after this download.

Clear the data hold area in V zone after
downloading

After this option is checked, all data in data retention area V and C will
be cleared after this download, otherwise, data in data retention area V
and C will remain unchanged after this download.

After click [OK], you will enter the USB flash drive and select the required PLC project file (default.obj

format). The.obj format file is automatically generated after the project is compiled. If there is no such format file in

the folder of the USB flash drive, the user needs to reopen the KincoBuilder project file for automatic generation

after compilation.

Select the program and click[OK] to update the program. If the PLC has been encrypted, a password box will

pop up for verification when downloading, enter the password and click OK to download normally. The device will

restart automatically after the USB flash drive transfers the PLC program successfully.

Figure 5.9-7 Folder in USB flash drive

Figure 5.9-8 Select the.obj file
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Figure 5.9-9 Input password

5.10 KDManger

KDManager is an auxiliary software for HMI project upload, download and decompile, HMI firmware update,

and obtain HMI system information. It contains 8 processing modules: [Download Operate], [Upload Operate],

[System Operate], [Get Version], [Decompile Operate],[Net Pass THrough],[VIrtual COM Through], [Bridged

Net Pass Through], use these processing module is the premise of need MK and PC communication success, and

communication type and parameters can be set in the [Communication Set] in any page. It is recommended that

users communicate by USB-Slave interface without other Settings. HMI or PLC program can be downloaded.

Figure 5.10-1 KDManage initial interface
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Figure 5.10-2 Communication Set interface

5.10.1 Download/Upload Operate

After saving the configuration screen edited by KincoDTools,. dpj format file is generated. After compilation,

the. pkg , .pkgx file required for HMI is generated . Click[Download User Data] and find the.pkg or . pkgx files in

the project file saving path, and click [Open] to enter the download page.

Figure 5.10-3 Download Operate step1
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Figure 5.10-4 Download Operate step2

5.10.2 System Operate

Figure 5.10-5 System Operate interface

Name Description

GetHMI IP/PORT information Obtain the IP address and port number of the current HMIWiFi, LAN0, and LAN1

Wi-Fi set Scan out the currently available WiFl, and set to select the network to be
connected

APN set
A parameter that the user must configure when surfing the internet
through the HMI, which determines the way the user HMl accesses the
mobile network

Set LANIP/PORT Update the IP address and port number to the set value

Return User Application Status HMI jumps to run the configuration program



MK series integrated(PLC+HMI) user manual

88

Return Set Application Status HMI changes to the embedded SETUP interface

Write Firmware

To update the HMI kernel and file system,user need to use this function
under the guidance of the manufacturer. Before updating the firmware,
user need to back up the configuration engineering and formula data
running on the HMI to avoid data loss after the update

Synchronization system time Synchronize computer time to HMI

5.10.3 Get Version

In the successful communication state, user can directly click [Get Version] to view the HMI firmware version

information.

Figure 5.10-6 Get version

Figure 5.10-7 Successfully obtained version information
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5.10.4 Decompile Operate

Decompile operate can reverse compile the.pkgx file in the MK to generate a project folder and save it on the

computer, and then open KincoDTools for editing.

Operation steps:

1. Select the target .pkg , .pkgx files to be decompiled

2. Select Decompile Target Project Directory means to select the storage path of the decompilation project

folder;

3. Click [Decompile], the password input box will pop up, if no password is set, enter the default password:

888888, click [OK] to decompile.

Figure 5.10-8 Select the.pkgx file

Figure 5.10-9 Input password window
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Figure 5.10-10 Decompiler successfully

5.10.5 Decrypt Operation

KincoDTools supports data encryption components: trend chart components, XY chart components, and

historical data display components. These components continuously collect data during operation, and the collected

data (historical data) can be optionally generated into CSV format files and saved to the recipe data area or external

storage devices.

Open editing configuration screen, check the [Encryption] on the component properties page to encrypt the

generated CSV file and protect the security of the collected data information.

Figure 5.10-11 Histoticsl Events Storage interface

After the encrypted CSV file is opened, garbled characters are displayed. You need to click [Decrypte Historic

Data File] to see the correct data information. What should be noted is:
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1. If the encrypted file is changed manually, KDManager [Decrypte Historic Data File] will prompt an error,

informing the user that the source file is damaged

2. After [Decrypte Historic Data File] is performed by KDManager, you can only open and view, but cannot

modify and edit CSV files or PDF files

5.10.6 Through communication method

KDManager supports three through communication methods: Net Pass Through, Virtual COM Through, and

Bridge Net Pass Through

Net Pass Through: The current communication method needs to be selected as network port. Once pass through
is enabled, a connection between HMI and PLC can be established, and PLC software can be used to monitor or
download the PLC.

Virtual COM Through:The PC establishes communication with the HMI through the virtual device according to

the communication parameters in "PC→HMI Parameter Settings", and the HMI communicates with the PLC through

the communication mode in "HMI→PLC parameter Settings", so that the PLC software can be used on the computer

to monitor and operate the connected PLC.

Bridge Net Pass Through:The PC is connected to the Intranet of PLC and HMI, so that the PLC program of the

remote device can be uploaded, downloaded and monitored.

For detailed , see KincoDTools user manual section 8.9~8.11.
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6 Services and Support

6.1 Services

Technical Support Hotline

If you have any questions about product selection or usage, you can seek technical support by calling our

technical support hotline: 400-700-5281.

Agents and Offices

If you have any questions about the products described in this manual, please contact the local offices and

agents of Kinco. For information regarding user training and other matters, please visit the company's website or

contact local agents for training plans.

6.2 Contact Us

Kinco(Shanghai) Automation Co., Ltd.
Address: Building 3, No. 26 Qiuyue Road, Zhangjiang High-Tech Park, Shanghai (201203)
Tel: 86-21-68798588
Fax: 86-21-68797688
Email: sales@kinco.cn

Kinco Electric Co., Ltd. Shenzhen Branch
Address: 3rd Floor, Building 1, Yizhongli Industrial Park, No. 6 Langshan 1st Road, North District,
High-Tech Park, Nanshan District, Shenzhen (518057)
Tel: 86-755-26585555 (12 lines)
Fax: 86-755-26616372
Email: sales@kinco.cn
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7 Appendix

7.1 Fast selection list

Standard type MK070E-33DT MK070E-32DX MK043E-20DT

Switch value

DI 16*DC24V 16*DC24V 9*DC24V

DO 14*DC24V
4*DC24V
12*Relay

9*DC24V

DIO / / /

Analog value
AI 2*AI /

2*A I(support 0-10V
signal)

AO 1*AO / /

Download
interface

USB-B √ √ √

Type-C × × ×

RS485(Port1) √ √ √

Communication

CAN 1 1 1
RS485 2 2 2

RS232 × × ×

Expansion module Up to 8 KS expansion module
Screen size 7’’TFT 7’’TFT 4.3’’TFT

Screen quality
Resolution 800*480 480*272
Color 256K color

Luminance 250 cd/m2

HMI type 4-wire precision resistance network HMI
Expansion interface USB-Host (Extended memory and external device)

Communication download
interface

Ethernet
USB-B

 The DC24V of DI and DO in the table indicate the transistor type. DI supports NPN/PNP input, DO supports
only PNP output, and Relay indicates the relay type.

 MK model with relay output do not support high-speed pulse output
 AI and AO support 4-20mA/1-5V/0-20mA/0-10V signals without special instruction
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Standard type MK070E-27DRT MK043E-20DTC MK043E-27DT

Switch value
DI 12*DC24V 9*DC24V 10*DC24V
DO 12*Relay 9*DC24V 10*DC24V
DIO / / 4*DC24V

Analog value
AI

3*RD
Support Pt100
thermoelectric

resistance, temperature
range -40℃ ~ 240 ℃

2*TC
Support J/K/E/T
thermocouples

2*AI

AO / / 1*AO

Download
interface

USB-B √ √ ×

Type-C × × √

RS485(Port1) √ √ √

Communication

CAN 1 1 1
RS485 2 2 2

RS232 × × 1

Expansion module Up to 8 KS expansion module
Screen size 7’’TFT 4.3’’TFT

Screen quality
Resolution 800*480 480*272
Color 256K color

Luminance 250 cd/m2

HMI type 4-wire precision resistance network HMI
Expansion interface USB-Host (Extended memory and external device)

Communication download
interface

Ethernet
USB-B

 The DC24V of DI and DO in the table indicate the transistor type. DI supports NPN/PNP input, DO supports
only PNP output, and Relay indicates the relay type.

 MK model with relay output do not support high-speed pulse output
 AI and AO support 4-20mA/1-5V/0-20mA/0-10V signals without special instruction
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Economic type MK070C-33DT MK043C-20DT

Switch value
DI 16*DC24V 9*DC24V
DO 14*Relay 9*DC24V
DIO / /

Analog value
AI 2*AI

2*AI
Support 0-10V signal

AO 1*AO /

Download interface

USB-B √ √

Type-C × ×

RS485(Port1) √ √

Communication

CAN × ×

RS485 1 1

RS232 × ×

Expansion module NO support
Screen size 7’’TFT 4.3’’TFT

Screen quality
Resolution 800*480 480*272
Color 256K color

Luminance 250 cd/m2 400 cd/m2

HMI type 4-wire precision resistance network HMI
Expansion interface USB-Host

Communication download interface
NO Ethernet
USB-B

 The DC24V of DI and DO in the table indicate the transistor type. DI supports NPN/PNP input, DO supports
only PNP output, and Relay indicates the relay type.

 AI and AO support 4-20mA/1-5V/0-20mA/0-10V signals without special instruction
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